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1 Altova DiffDog Server 2018

DiffDog Server is a powerful differencing software solution that enables you to compare text and
XML files, directories (including ZIP format), as well as URLs, across Windows, Linux, and Mac
OS X systems.

DiffDog Server Features
Command-line Interface. DiffDog Server runs as a service. You can run comparisons by
invoking DiffDog Server either from the command line interface or through executable
scripts.
Run comparisons remotely. You can compare files either directly on the server machine
where DiffDog Server is installed, or call a comparison remotely from a client machine.
The DiffDog Server installation includes a portable DiffDog Command Line Client, which
can be copied to multiple machines within your organization, thus enabling you to call a
running DiffDog Server remotely.
Cross-platform: DiffDog clients may run on either Linux, Mac OS X, or Windows, and the
same is true for DiffDog Server.
URL Comparisons. In addition to files and directories, you can also compare URLs. For
example, you can compare a page like http://www.example.org/page1.html with
http://www.example.org/page2.html. Combinations between URL and files are also
possible, for example, http://www.example.org/page1.html with C:\page2.html.
Three-way comparisons. In addition to standard two-side comparisons that involve a "left"
file and a "right" side, you can also perform three-way comparisons (when comparing
files). This is useful, for example, when two different versions exist of the same original
file, and you need to cross-compare all versions.
Binary, text, and XML. Depending on the kind of files you are comparing, you can choose
between any of the following comparison modes: binary, text, or XML. Alternatively, you
can let the application detect the comparison mode automatically based on file
extension. For even more advanced needs, you can create custom rules to choose a
specific mode automatically based on file extension.
Advanced filters and comparison options. You can flexibly include or exclude files or
directories from a comparison by means of filters. Additional options are available that
help you deal with case-sensitive versus insensitive comparisons, ignoring files based on
size or modification time, as well as various ways to treat special characters like spaces,
tabs, or carriage returns.
Integration with DiffDog desktop. If you have already created comparison files (such as
.filedif and .dirdif files) in DiffDog (https://www.altova.com/diffdog), you can compare them
in a server environment as well. This enables you to automate or integrate frequently-used
comparisons into your custom scripts or processes. On Windows, any custom XML or
directory filters that you have created in DiffDog can also be invoked as command line
options when you run a comparison with the DiffDog Command Line Client executable.

Limitations
The connection between client and server is currently unencrypted (plain HTTP).

https://www.altova.com/diffdog
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System Requirements

Windows Windows 7 SP1 with Platform Update, Windows 8,
Windows 10

Windows Server Windows Server 2008 R2 SP1 with Platform Update or
newer

Linux CentOS 6 or newer
RedHat 6 or newer
Debian 7 or newer
Ubuntu 12.04 or newer

(Mac) OS X, macOS OS X10.10, 10.11, macOS 10.12 or newer

On Windows, DiffDog Server is available both as a 32-bit and 64-bit package.

Last updated: 28 May 2018
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1.1 How It Works

After installation, the DiffDog Server files are copied in the default program installation directory.

Windows C:\Program Files\Altova\DiffDogServer2018\

Linux /opt/Altova/DiffDogServer2018/

OS X / macOS /usr/local/Altova/DiffDogServer2018/

The program installation directory contains two executables that you will work with:

1. DiffDog Server executable, available in the bin subdirectory. This executable provides
configuration-related commands, including commands for licensing DiffDog Server,
starting it as a service, or resetting it to the default configuration.

2. DiffDog Command Line Client executable, available in the cmdlclient subdirectory. This
executable provides the diff command (among other commands). The diff command is
the most important command, and you can use it to run comparisons between any of the
following: files, directories, or URLs.

In this documentation, the DiffDog Command Line Client executable is alternatively referred to
as "DiffDogCmdlClient". 

To begin, let's open a command line terminal and run a simple command that returns the current
version of DiffDog Server:

Windows "C:\Program Files\Altova\DiffDogServer2018\bin\DiffDogServer"
--version

Linux /opt/Altova/DiffDogServer2018/bin/diffdogserver --version

OS X / macOS /usr/local/Altova/DiffDogServer2018/bin/diffdogserver --version

Let's now run an actual comparison between two local files. This time, make sure that you call
the DiffDogCmdlClient (not server) executable with the diff command, as follows:

Windows "C:\Program Files\Altova\DiffDogServer2018\cmdlclient
\DiffDogCmdlClient.exe" diff file1.txt file2.txt

Linux /opt/Altova/DiffDogServer2018/cmdlclient/bin/diffdogcmdlclient
diff file1.txt file2.txt

OS X / macOS /usr/local/Altova/DiffDogServer2018/cmdlclient/bin/
diffdogcmdlclient diff file1.txt file2.txt

Note that, for the sake of simplicity, this documentation omits the full path to the executable when
describing commands. Therefore, instead of the command above, this documentation uses:

DiffDogCmdlClient diff file1.txt file2.txt
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The command above is very simple and assumes that:

The current working directory is the program directory.
The files file1.txt and file2.txt exist in the program directory (otherwise, refer to them
using an absolute or a relative path).
DiffDog Server and DiffDog Command Line Client both run on the same machine.

Note the following:

To call the executable (either client or server) just by name, without the full path, add the
program installation directory to your system's PATH variable. Alternatively, run the cd
command and switch to the directory where the executable is.
On Linux, use an all-lowercase to call the executable. In addition, on Linux and OS X /
macOS, when you are inside the directory of the executable, you might need to add the
prefix "./" before the name of the executable.

DiffDog Command Line Client can run either on the same machine as DiffDog Server, or on a
different machine. When installed on another machine, the client it is capable of communicating
with a remote DiffDog Server through HTTP. Consequently, the diff command can compare not
only file or directory paths local to the client, but also paths on the remote machine where DiffDog
Server runs. You can also compare a client-side file or directory with a remote server-side file or
directory, or vice versa. Moreover, the client and the server can be on different operating systems
(for example, the client may be running on Windows and the server on Linux). The advantage of
such a setup is that it enables you to run comparisons from virtually any client configured to
communicate with the server. For instructions about how to configure the server to accept calls
from remote clients, see Configuring the Server.

The diff command provides a large number of additional options for advanced comparison needs,
for example:

You can specify whether files should be compared as text, XML, or binary files. 
You can create custom rules that let you automatically set a comparison mode (text,
XML, binary) based on file extension.
When two directories are compared, you can specify whether file contents are to be
compared also.
You can specify whether the file size or modification date should be ignored or taken into
account when comparing files.
When you compare text files, you can specify rules to exclude from the comparison files
that match a certain name pattern.
When you compare XML files, you can specify rules to exclude from the comparison
certain XML elements and attributes.
You can specify how the comparison results are to be generated. For example, you can
redirect the comparison result (output) either to a file on the server, or to a file on the
client. Regardless of the option chosen, you can additionally view the output on screen.
The comparison results can be either in text or in XML format.

This is not an exhaustive list; for reference to all available comparison options, see the diff
command reference.
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2 Installation

2.1 Linux

2.1.1 Installing DiffDog Server

System requirements
Linux

CentOS 6 or newer
RedHat 6 or newer
Debian 7 or newer
Ubuntu 12.04 or newer

The following libraries are required as a prerequisite to install and run the application. If the
packages below are not already available on your Linux machine, run the command yum (or
apt-get if applicable) to install them.

Required by CentOS, RedHat Debian Ubuntu

LicenseServer krb5-libs libgssapi-krb5-2 libgssapi-krb5-2

Prerequisites
Perform installation either as root user or as a user with sudo privileges.
The previous version of DiffDog Server must be uninstalled before a new one is installed.

Installing DiffDog Server
1. Download the installation package from https://www.altova.com/download#server to a

local directory.
2. Change to the directory where you downloaded the installation package, for example:

cd /home/User/Downloads

3. Install the DiffDog Server package.

[Debian, Ubuntu]   sudo dpkg --install diffdogserver-2018-debian.deb
[CentOS, RedHat]   sudo rpm -ivh diffdogserver-2018-1.x86_64.rpm

Note: You may need to adjust the name of the package above to match the current release or
service pack version.

4. Start the DiffDog Server service.

https://www.altova.com/download#server
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[CentOS 6]:    sudo initctl start diffdogserver 
[CentOS 7]:    sudo systemctl start diffdogserver
[Debian 7]:    sudo /etc/init.d/diffdogserver start 
[Debian 8]:    sudo systemctl start diffdogserver
[RedHat 6]:    sudo initctl start diffdogserver
[RedHat 7]:    sudo systemctl start diffdogserver
[Ubuntu 14]:   sudo initctl start diffdogserver
[Ubuntu 15]:   sudo systemctl start diffdogserver

Licensing DiffDog Server
1. Ensure that the latest version of Altova LicenseServer (https://www.altova.com/

licenseserver) is installed and running either on the local machine or network.
2. Register DiffDog Server with Altova LicenseServer. For this, you need to know either the

host name or the IP address of the computer where LicenseServer runs. For example, if
LicenseServer runs on 127.0.0.1, you can register it as follows:

sudo diffdogserver licenseserver 127.0.0.1

Note: The command above assumes you are calling the executable from the program
installation directory. On CentOS and OS X, make sure to prepend "./" in front of the executable.

3. Log on to LicenseServer administration interface and assign the license to the machine
where DiffDog Server runs.

For more information about licensing, refer to Altova LicenseServer documentation (https://
www.altova.com/documentation).

2.1.2 Viewing Currently Installed Products

To check if an Altova server product is installed:

Run the following command:

[Debian, Ubuntu]   dpkg --list | grep server
[CentOS, RedHat]   rpm -qa | grep server

2.1.3 Uninstalling DiffDog Server

To uninstall DiffDog Server:

Run the following command:

[Debian, Ubuntu]  sudo dpkg --remove diffdogserver
[CentOS, RedHat]  sudo rpm -e diffdogserver

https://www.altova.com/licenseserver
https://www.altova.com/licenseserver
https://www.altova.com/documentation
https://www.altova.com/documentation
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If you need to uninstall other packages, use the same command as above and supply the
package you want to remove as argument. For example:

[Debian, Ubuntu]  sudo dpkg --remove licenseserver
[CentOS, RedHat]  sudo rpm -e licenseserver
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2.2 OS X / macOS

2.2.1 Installing DiffDog Server

System requirements
(Mac) OS X, macOS

OS X 10.10 or newer

Prerequisites
Perform installation as a user with administrative (root) privileges.

Installing DiffDog Server
1. Download the disk image (.dmg) file from the Altova Download Center (https://

www.altova.com/download) and click to open it. Once you do this, the installer appears
as a new drive on your computer.

2. Double-click the package (.pkg) file, and go through the successive steps of the
installation wizard. These are self-explanatory and include one step in which you have to
agree to the license agreement before being able to proceed. When you complete the
wizard, the DiffDog Server icon becomes available in Applications. The package is
installed in the directory /usr/local/Altova/DiffDogServer2018/ .

3. If you have not installed Altova License Server already, or if you want to upgrade to the
latest version, double-click the corresponding package (.pkg) file and follow the on-screen
instructions.

4. Start DiffDog Server as a service.

sudo launchctl load /Library/LaunchDaemons/
com.altova.DiffDogServer.plist

Licensing DiffDog Server
1. Ensure that the latest version of Altova LicenseServer (https://www.altova.com/

licenseserver) is installed and running either on the local machine or network.
2. Register DiffDog Server with Altova LicenseServer. For this, you need to know either the

host name or the IP address of the computer where LicenseServer runs. For example, if
LicenseServer runs on 127.0.0.1, you can register it as follows:

sudo diffdogserver licenseserver 127.0.0.1

3. Log on to LicenseServer administration interface and assign the license to the machine
where DiffDog Server runs.

For more information, refer to Altova LicenseServer documentation (https://www.altova.com/

https://www.altova.com/download
https://www.altova.com/download
https://www.altova.com/licenseserver
https://www.altova.com/licenseserver
https://www.altova.com/documentation
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documentation).

2.2.2 Uninstalling DiffDog Server

To uninstall DiffDog Server:

1. Stop the DiffDog Server service.

sudo launchctl unload /Library/LaunchDaemons/
com.altova.DiffDogServer.plist

To check whether a service has been stopped, open the Activity Monitor terminal and
make sure that the service is not in the list. Double-check that the Activity Monitor shows
all processes, not just "My processes" (On the View menu, click All processes.)

2. In Applications, right-click the DiffDog Server icon and select Move to Trash. Note that
your DiffDog Server installation directory and configuration data are not removed by this
step.

3. Optionally, if you want to remove the DiffDog Server installation directory as well, run the
following command:

sudo rm -rf /usr/local/Altova/DiffDogServer2018/ 

Note: The steps above do not remove the configuration data from /var/Altova/
DiffDogServer2018. Be aware that once the configuration data is removed, it cannot be
recovered later.

https://www.altova.com/documentation
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2.3 Windows

2.3.1 Installing DiffDog Server

System requirements
Windows 7 SP1 with Platform Update, Windows 8, Windows 10
Windows Server 2008 R2 SP1 with Platform Update or newer

Prerequisites
Perform installation as a user with administrative privileges.

Installing DiffDog Server
1. Download the installation file from the Altova Download Center (https://www.altova.com/

download) and run it.
2. Optionally, select the installation language from the box in the lower left area of the

wizard, and click Next. If necessary, you can change the language later from the
command line.

3. Do one of the following:

a. If you haven't installed Altova LicenseServer yet, leave the default settings as is. The
wizard will install the latest version of Altova LicenseServer on the computer where
you are running the wizard.

b. If you haven't installed Altova LicenseServer yet and want to install Altova
LicenseServer on another computer, clear the Install Altova LicenseServer on this
machine check box, and then choose Register Later. In this case, you will need to
install Altova LicenseServer and register DiffDog Server separately.

c. If Altova LicenseServer has already been installed on your computer but it has a lower
version than the one indicated by the installation wizard, leave the default settings as
is. In this case, the installation wizard will automatically upgrade your LicenseServer
version with the one indicated on the dialog box. Note that the existing registration
and licensing information will be preserved after the upgrade.

d. If Altova LicenseServer has already been installed on your computer or network, and if
it has the same version as the one indicated by the wizard, do the following:
i. Clear the Install Altova LicenseServer on this machine check box.
ii. Under Register this product with, choose the Altova LicenseServer instance on

which you want to register DiffDog Server, or choose Register later.

4. Click Next.
5. Optionally, define the port number on which HTTP clients can communicate with DiffDog

Server. You can also change this setting later, see Configuring the Server .

https://www.altova.com/download
https://www.altova.com/download
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6. Optionally, define the Windows service configuration applicable to DiffDog Server. For
more information, see Configuring Windows Service Settings. 

7. Follow the wizard instructions to complete the installation. When the installation

completes, the Altova ServiceController icon (  ) is added in the system notification
area.

Licensing DiffDog Server
1. Ensure that the latest version of Altova LicenseServer (https://www.altova.com/

licenseserver) is installed and running either on the local machine or network. 
2. If you haven't done so already during installation, register DiffDog Server with Altova

LicenseServer. For this, you need to know either the host name or the IP address of the
computer where LicenseServer runs. For example, if LicenseServer runs on 127.0.0.1,
you can register it as follows:

DiffDogServer.exe licenseserver 127.0.0.1

3. Log on to LicenseServer administration interface and assign the license to the machine
where DiffDog Server runs.

For more information, refer to Altova LicenseServer documentation (https://www.altova.com/
documentation).

2.3.2 Configuring Windows Service Settings

During the installation of DiffDog Server on a Windows operating system, it is possible to
configure the following settings:

https://www.altova.com/licenseserver
https://www.altova.com/licenseserver
https://www.altova.com/documentation
https://www.altova.com/documentation
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How should DiffDog Server start up as a Windows service: automatic, on demand,
delayed automatic, or disabled.
The operating system user account to be used by DiffDog Server as a Windows service: 
Local System, Local Service, Network Service, or Other User.
If DiffDog Server is configured to run as Other User, you can set the username and
password of this user, similar to how this is done in the Windows Services management
console.

The settings have the same meaning as when you change the service properties from the
Windows Services management console. To define the settings above during installation, click
Change next to Service configuration.

If you need to change these settings after installation, open the Windows Services management
console, and then change the properties of the required service from there. To open the Windows
Services management console, open a command line window and type Services.msc.
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3 Configuring the Server

Configuration of DiffDog Server involves setting the server configuration file—one such file in .ini
format exists on the server machine in the application data directory:

Linux /var/opt/Altova/DiffDogServer

Mac /var/Altova/DiffDogServer

Windows 7, 8, 10 C:\ProgramData\Altova\DiffDogServer

For typical scenarios where configuration of the server is required, see Configuring the Server for
Remote Comparisons.

In addition, if you want to use DiffDog Server for remote comparisons, a client configuration file,
also in .ini format, must be configured on each client machine that connects to DiffDog Server
remotely. 

You can change the settings available in configuration files by editing the files in a text editor. For
reference to all settings available in these files, see:

Server Configuration File
Client Configuration File

After editing the server configuration file, restart DiffDog Server as a service.

For information about restarting DiffDog Server as a service, see:

Starting and Stopping Services (Linux)
Starting and Stopping Services (OS X / macOS)
Starting and Stopping Services (Windows)
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3.1 Configuring the Server for Remote Comparisons

To enable remote DiffDog Clients to call DiffDog Server, take the following steps:

1. On the server machine, make sure that DiffDog Server is installed, licensed and running
(see Setup on Windows, Setup on Linux and Setup on macOS).

2. On the server machine, define the HTTP host and port where DiffDog Server should be
listening for client requests. By default, DiffDog Server is configured to listen to HTTP
connections on the address and port specified in a server configuration file. By editing the
server configuration file, you can specify a different address and port. To make
DiffDogServer accept incoming connections from other machines, ensure that the 
http.socket-host parameter is set to 0.0.0.0.

Ensure that the host and port on the server machine are not blocked by the firewall.
For example, on a Windows server, you can let an application through the firewall by
editing the rules available in Control Panel\All Control Panel Items\Windows
Defender Firewall.

3. Restart DiffDog Server as a service. For instructions, see:

Starting and Stopping Services (Linux)
Starting and Stopping Services (OS X / macOS)
Starting and Stopping Services (Windows)

4. Locate the cmdlclient subdirectory of the program installation directory and copy it to
the client machine. You will find this directory at the following path:

Windows C:\Program Files\Altova\DiffDogServer2018\cmdlclient

Linux /opt/Altova/DiffDogServer2018/cmdlclient

OS X /
macOS

/usr/local/Altova/DiffDogServer2018/cmdlclient

At minimum, you should copy the executable and the .ini configuration file available in the
same directory; other files are optional. If you intend to call DiffDog Server remotely from
more than one client machine, then copy the cmdlclient directory to each client machine
that needs to call DiffDog Server. 

If the client machine runs on a different operating system than the server machine, take
the following steps:

a) Download the server installation package from the Altova download page (https://
www.altova.com/download) and install it on the client operating system. After installation,
you will find the client files in the cmdlclient subdirectory relative to the program
installation directory. 
b) Copy the cmdlclient subdirectory to another location and uninstall the server package
from the client machine.

5. On the client machine, edit the client configuration file so that it points to the address and

https://www.altova.com/download
https://www.altova.com/download
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port where DiffDog Server listens for HTTP requests. For example, let's assume that
DiffDog Server listens on 192.0.2.0 and port 29800. In this case, edit the client
configuration file so that server.host and server.port parameters have these
respective values.

On the client machine, you are now ready to call the remote DiffDog Server in order to compare
some files or directories. For example, the command below will compare path\to\my\file1.txt
on the client with path\to\my\file2.txt on the server, using text comparison mode. Note that,
in order for diff command to work correctly, these file paths must actually exist on the client and
server machine, respectively.

diffdogcmdlclient diff --client-left=path\to\client\file.txt --server-
right=path\to\server\file.txt --mode=text

When you run the command, DiffDog Client reads the connection details from the client
configuration file, connects to DiffDog Server, and performs the comparison. As stated before, the
configuration file must point to a host and port where DiffDog Server is up and running, and listens
for HTTP requests.



© 2018 Altova GmbH

Server Configuration File 25Configuring the Server

Altova DiffDog Server 2018 

3.2 Server Configuration File

After installation, DiffDog Server contains a server configuration file called server_config.ini
located in the application data directory. The application data directory depends on the operating
system:

Linux /var/opt/Altova/DiffDogServer

Mac /var/Altova/DiffDogServer

Windows 7, 8, 10 C:\ProgramData\Altova\DiffDogServer

To create a DiffDog Server configuration file with the default configuration settings, run the 
createconfig command.

A sample server configuration file is listed below.

[DiffDogServer]

http.access-file= C:\ProgramData\Altova\DiffDogServer2018\Log\access.log
http.enable=True
http.environment= production
http.error-file= C:\ProgramData\Altova\DiffDogServer2018\Log\error.log
http.log-screen= True
http.socket-host=0.0.0.0
http.socket-port=29800
language= en
server.unrestricted-filesystem-access= True
server.log-file= C:\ProgramData\Altova\DiffDogServer2018\Log\server.log
server.output-root-dir= C:\ProgramData\Altova\DiffDogServer2018\output\

server_config.ini

The server configuration file includes the following options.

Option Description

http.access-file Defines the name and location of the HTTP access log file. The
access file contains information about access-related activity. It
contains information that is useful for resolving connection issues.

http.enable Specifies whether DiffDog Server should listen for HTTP requests
from clients. Valid values:

True Enable

False Disable

Note: This option must be enabled even if the client and server both
run on the same machine; otherwise, the client will not be able to
communicate with the server.
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Option Description

http.environment Sets the environment (development or production). The
development production allows for easier debugging compared to
the production one. Valid values:

production Set environment to production.

development Set environment to development.

http.error-file Defines the name and location of the HTTP error file. The error file
contains errors related to traffic to and from the server. If there are
connection problems, this file can provide useful information
towards resolving them.

http.log-screen If you started DiffDog Server with the command debug, and if this
option is set to true, then server activity is displayed in the
command line console. Otherwise, server activity is not displayed.
The log screen is displayed in addition to the writing of log files.

http.socket-host Defines the address (HTTP interface) on which DiffDog Server
should listen for HTTP requests. This should be an IP address
from one of the network interfaces configured at the machine or the

name localhost. To have DiffDog Server listen on all interfaces, set

this value to 0.0.0.0. If it should listen for local requests only, set
this value to 127.0.0.1.

http.socket-port Defines the port on which DiffDog Server should listen for HTTP
requests.

language Specifies the language of the command line interface. Valid values
are en, de, es, fr, ja (English, German, Spanish, French, and
Japanese).

server.log-file Defines the name and location of the server's log file. This file
contains general activity events logged by the server, including
licensing events.

server.output-root-
dir

Specifies the directory where the output of all submitted jobs is
saved.

server.unrestricted-
filesystem-access

When set to True (the default value), output files are written
directly to the location specified by the user (possibly overwriting
existing files of the same name). Setting the value to True is
meaningful if the client and server are on the same machine and
you want to write the output files to any directory on that machine.
If DiffDog Server is configured to accept HTTP requests from
remote clients, this setting must be set to False.

When set to False, output files are written to the output directory
(see the server.output-root-dir option).
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3.3 Client Configuration File

A client-side configuration file defines various configuration settings that affect comparisons and
connectivity between DiffDog Command Line Client and a remote DiffDog Server. You must
typically edit the client configuration file in order to achieve the following:

Set up the communication between DiffDog Command Line Client and a remote DiffDog
Server. In this case, the server.address and server.port parameters in the client
configuration file must point to the machine where DiffDog Server runs.
Change the language of the command line interface (for the client).
Set default values for various options when you run a comparison. For example, if you
don't specify a comparison mode (binary, text) when comparing files, the application will
use the default comparison mode as it is configured in the client configuration file.
Define XML filters. An XML filter is useful when you are comparing XML files. It lets you
ignore attributes or elements with a specific name during comparison.
Define directory filters. When you compare directories, a directory filter lets you include or
ignore files or directories that follow a specific pattern.
Other configuration options, as further described below.

If you do not need the functionality above, there is no need to set up a client configuration file.
Otherwise, you can find a sample client configuration file in the cmdlclient subdirectory relative to
the program installation directory; it is called client_config.ini.sample. To set up your custom
configuration file, create a copy of client_config.ini.sample and remove the .sample part from
the file name.

When you run a comparison, you can set the path to the custom configuration file by setting the
--c option. If you do not set the --c option, the DiffDog Command Line Client executable attempts
to read the client configuration file from the same directory. If there is no configuration file in the
same directory as the executable, the default values as described in the command line help and
this documentation apply.

To view the current configuration, run the showcfg command.

The client configuration file includes the options listed below.

[general]

Option Description

language Specifies the language of the command line interface (for the client). Valid
values are en, de, es, fr, ja (English, German, Spanish, French, and
Japanese).

server.address Specifies the address of the remote host where DiffDog Server is listening
for HTTP requests. 

server.port Specifies the remote port where DiffDog Server is listening for HTTP
requests.

zip-as-dir When you run the diff command without setting the --zip-as-dir
option, the executable will look for it in this configuration file. Set here the
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Option Description

default preferred value for this option.

whitespace-
mode

When you run the diff command without setting the --whitespace-mode
option, the executable will look for it in this configuration file. Set here the
default preferred value for this option.

[file-types]
When you run the diff command without specifying a comparison mode through the --mode option
(text, binary, or XML), the application decides the comparison mode automatically for each file
based on extension (that is, --mode=auto). In the options below, you can define what file
extensions should be treated as text, binary, or XML, whenever the comparison mode is not
explicitly set.

Option Description

text A comma-separated list of file extensions that are treated as text by
default.

xml A comma-separated list of file extensions that are treated as XML by
default.

binary A comma-separated a list of file extensions that are treated as binary by
default.

[xml]

Option Description

ignore-
namespace

When you run the diff command without setting the --xml-ignore-
namespace option, the executable will look for it in this configuration file.
Set here the default preferred value for this option.

ignore-
prefixes

When you run the diff command without setting the --xml-ignore-
prefixes option, the executable will look for it in this configuration file. Set
here the default preferred value for this option.

resolve-
entities

When you run the diff command without setting the --xml-resolve-
entities option, the executable will look for it in this configuration file. Set
here the default preferred value for this option.

ignore-text When you run the diff command without setting the --xml-ignore-text
option, the executable will look for it in this configuration file. Set here the
default preferred value for this option.

ignore-case-
in-names

When you run the diff command without setting the --xml-ignore-
case-in-names option, the executable will look for it in this configuration
file. Set here the default preferred value for this option. 
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Option Description

ignore-case-
in-text

When you run the diff command without setting the --xml-ignore-
case-in-text option, the executable will look for it in this configuration
file. Set here the default preferred value for this option. 

ignore-markup-
attributes

When you run the diff command without setting the --xml-ignore-
markup-attributes option, the executable will look for it in this
configuration file. Set here the default preferred value for this option. 

ignore-markup-
cdata

When you run the diff command without setting the --xml-ignore-
markup-cdata option, the executable will look for it in this configuration
file. Set here the default preferred value for this option. 

ignore-markup-
comments

When you run the diff command without setting the --xml-ignore-
markup-comments option, the executable will look for it in this configuration
file. Set here the default preferred value for this option. 

ignore-markup-
processing-
instructions

When you run the diff command without setting the --xml-ignore-
markup-processing-instructions option, the executable will look for it
in this configuration file. Set here the default preferred value for this option. 

ignore-markup-
doctype-decls

When you run the diff command without setting the --xml-ignore-
markup-doctype option, the executable will look for it in this configuration
file. Set here the default preferred value for this option. 

ignore-markup-
xml-decls

When you run the diff command without setting the --xml-ignore-
markup-xml option, the executable will look for it in this configuration file.
Set here the default preferred value for this option. 

order-by-
elements

When you run the diff command without setting the --xml-order-by-
elements option, the executable will look for it in this configuration file. Set
here the default preferred value for this option. 

order-by-
attributes

When you run the diff command without setting the --xml-order-by-
attributes option, the executable will look for it in this configuration file.
Set here the default preferred value for this option. 

order-by-text When you run the diff command without setting the --xml-order-by-
text option, the executable will look for it in this configuration file. Set here
the default preferred value for this option. 

order-by-list When you run the diff command without setting the --xml-order-by-
attribute-list option, the executable will look for it in this configuration
file. Set here the default preferred value for this option. This must be a
named list of attributes defined in the [xml.orderby<name-of-my-list>]
group (see below).

[xml.orderby:<identifier>]
This option group represents a named list of XML attributes. When an XML comparison takes
place, such a list will cause the XML elements to be ordered by specific attributes before
comparison. For an example, see the --xml-order-by-attribute-list option. You can create
multiple attribute lists, for example [xml.orderby:list1], [xml.orderby:list2], and so on. The name of
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each attribute list must be unique.

Option Description

attributes Enter here the attribute by which XML elements must be ordered before
comparison, for example:

attributes = myattribute

You can also specify a comma-separated list of XML attributes, for
example:

attributes = attr1, attr2, attr3

[xml.filter:<identifier>]
This option group represents a filter that lets you ignore attributes or elements with a specific
name during comparison. You can create multiple such option groups, for example 
[xml.filter:filter1], [xml.filter:filter2], and so on. The name of each option group must be unique.

Option Description

ignore-
elements

Enter here a comma-separated list of XML elements that should be ignored
when this filter is active.

ignore-
attributes

Enter here a comma-separated list of XML attributes that should be ignored
when this filter is active.

ignore-both Enter here a comma-separated list of XML elements or attributes that
should be ignored when this filter is active.

Once you define a filter in the configuration file, you can supply it at the command line using the 
--xml-filter option.

[text]

Option Description

ignore-case When you run the diff command without setting the --ignore-case
option, the executable will look for it in this configuration file. Set here the
default preferred value for this option. 

ignore-blank-
lines

When you run the diff command without setting the --ignore-blank-
lines option, the executable will look for it in this configuration file. Set
here the default preferred value for this option. 
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[dir]

Option Description

ignore-case When you run the diff command without setting the --dir-ignore-case
option, the executable will look for it in this configuration file. Set here the
default preferred value for this option. 

compare-file-
content

When you run the diff command without setting the --dir-compare-
contents option, the executable will look for it in this configuration file. Set
here the default preferred value for this option. 

compare-sizes When you run the diff command without setting the --dir-compare-
sizes option, the executable will look for it in this configuration file. Set
here the default preferred value for this option. 

compare-
modification-
times

When you run the diff command without setting the --dir-compare-
mod-times option, the executable will look for it in this configuration file.
Set here the default preferred value for this option. 

ignore-
modtime-
interval

When you run the diff command without setting the --dir-compare-
mod-times-ignore-seconds option, the executable will look for it in this
configuration file. Set here the default preferred value for this option. 

[dir.filter:<identifier>]
This option group represents a filter that lets you include or ignore files or directories that follow a
specific pattern. At the command line, you can specify directory filters using the --directory-

filter option. In the configuration file, you can create multiple such option groups, for example

[dir.filter:filter1], [dir.filter:filter2], and so on. The name of each option group must be unique. Each
option group can contain one or more of the following options:

Option Description

ignore-files A list of file extensions that should be excluded from the comparison
(ignored) when this filter is active.

ignore-dirs A list of directory names that should be excluded from the comparison
(ignored) when this filter is active.

include-dirs A list of directory names that should be included in the comparison
when this filter is active.

include-files A list of file extensions that should be included in the comparison when
this filter is active.

include-archive-
files

Windows-specific. Set this value to true if archive files should be
included in the filter; false otherwise.

include_hidden_dir
s

Windows-specific. Set this value to true if hidden directories should be
included in the filter; false otherwise.

include_hidden_fil
es

Windows-specific. Set this value to true if hidden files should be
included in the filter; false otherwise.
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Option Description

include-readonly-
files

Windows-specific. Set this value to true if read-only files should be
included in the filter; false otherwise.

include_system_dir
s 

Windows-specific. Set this value to true if system directories should
be included in the filter; false otherwise.

include_system_fil
es 

Windows-specific. Set this value to true if system files should be
included in the filter; false otherwise.

Note that the application contains a few built-in directory filters (and you don't need to create them
since they will be recognized even if you didn't define them in the configuration file). You can
however alter the definition of these filters in the configuration file, in which case your filter will
override the built-in configuration. The built-in filters are as follows:

Filter identifier Purpose

xml When this filter is active and a directory comparison is performed, files with
the following extensions are included in the comparison: *.biz, *.cml,
*.dcd, *.dtd, *.ent, *.fo, *.math, *.mml, *.mtx, *.rdf,
*.smil, *.svg, *.tld, *.tsd, *.vml, *.vxml, *.wml, *.wsdl,

*.xbrl, *.xdr, *.xhtml, *.xml, *.xsd, *.xsl, *.xslt.

On Windows, read-only and archive files are included in the comparison.

text When this filter is active and a directory comparison is performed, only files
with the following extensions are included in the comparison: *.asp, *.c,
*.cc, *.cpp, *.cs, *.css, *.cxx, *.h, *.hpp, *.htm, *.html,

*.java, *.jsp, *.rc, *.tlh, *.tli, *.txt.

On Windows, read-only and archive files are included in the comparison.

nobinary When this filter is active and a directory comparison is performed, files with
the following file extensions are ignored: a.out, *.a, *.avi, *.bmp,
*.chm, *.com, *.dll, *.doc, *.docm, *.docx, *.dot, *.dotm,
*.dotx, *.exe, *.gif, *.gz, *.hlp, *.ico, *.ilk, *.jar,
*.jpeg, *.jpg, *.lib, *.mdb, *.mid, *.mp2, *.mp3, *.mp4,
*.mpeg, *.msi, *.o, *.obj, *.ogg, *.pdb, *.pdf, *.png, *.pps,
*.ppt, *.pptx, *.rar, *.snd, *.so, *.tar, *.tif, *.tiff,
*.tlb, *.ttf, *.wav, *.wma, *.wmf, *.wmv, *.xls, *.xlsx, *.zip

cvs When this filter is active and a directory comparison is performed, files with
the following file extensions are
ignored: .#*, .cvsignore, .cvsrc, .cvswrappers, .cvspass, .rhos
ts. Also, any directory with the name CVS is ignored.

On Windows, read-only and archive files are also included in the
comparison.

svn When this filter is active and a directory comparison is performed, any
directory with the name .svn is ignored.

On Windows, read-only and archive files are included in the comparison.
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Filter identifier Purpose

git When this filter is active and a directory comparison is performed, any
directory with the name .git is ignored. Also, any file with the name
.gitignore is ignored.

On Windows, read-only and archive files are included in the comparison.
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3.4 Starting and Stopping Services (Linux)

To start the service:

[CentOS 6]:    sudo initctl start diffdogserver 
[CentOS 7]:    sudo systemctl start diffdogserver
[Debian 7]:    sudo /etc/init.d/diffdogserver start 
[Debian 8]:    sudo systemctl start diffdogserver
[RedHat 6]:    sudo initctl start diffdogserver
[RedHat 7]:    sudo systemctl start diffdogserver
[Ubuntu 14]:   sudo initctl start diffdogserver
[Ubuntu 15]:   sudo systemctl start diffdogserver

To stop the service:

[CentOS 6]:    sudo initctl stop diffdogserver
[CentOS 7]:    sudo systemctl stop diffdogserver
[Debian 7]:    sudo /etc/init.d/diffdogserver stop 
[Debian 8]:    sudo systemctl stop diffdogserver
[RedHat 6]:    sudo initctl stop diffdogserver
[RedHat 7]:    sudo systemctl stop diffdogserver
[Ubuntu 14]:   sudo initctl stop diffdogserver
[Ubuntu 15]:   sudo systemctl stop diffdogserver
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3.5 Starting and Stopping Services (OS X / macOS)

To start the service:

sudo launchctl load /Library/LaunchDaemons/
com.altova.DiffDogServer.plist

To stop the service:

sudo launchctl unload /Library/LaunchDaemons/
com.altova.DiffDogServer.plist
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3.6 Starting and Stopping Services (Windows)

By default, the DiffDog Server services are automatically started when Windows starts. Follow the
instructions below if you need to manage services manually.

To start the service:

Click the ServiceController icon (  ) in the system notification area, and then select
Altova DiffDog Server > Start service.

To stop the service:

Click the ServiceController icon (  ) in the system notification area, and then select
Altova DiffDog Server > Stop service.

You can also start or stop the DiffDog Server services using the Microsoft Management Console
(found under Control Panel > Administrative Tools > Services). 



Chapter 4

DiffDog Server Command Line
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4 DiffDog Server Command Line

This section: 

Default location of DiffDog Server executable  
Usage and list of CLI commands  

Default location of DiffDog Server executable
Given below are the default locations of the DiffDog Server executable:

Windows <ProgramFilesFolder>\Altova\DiffDogServer2018\bin

\DiffDogServer.exe 

Linux /opt/Altova/DiffDogServer2018/bin/diffdogserver

Mac /usr/local/Altova/DiffDogServer2018/bin/diffdogserver

Usage and list of CLI commands
General command line syntax for DiffDogServer is:

Windows DiffDogServer --h | --help | --version | <command> [options]

[arguments]

Linux diffdogserver --h | --help | --version | <command> [options]

[arguments]

Mac diffdogserver --h | --help | --version | <command> [options]

[arguments]

Casing and slashes on the command line

DiffDogServer on Windows

diffdogserver on Unix (Linux, Mac) 

* Note that lowercase (diffdogserver) works on all platforms (Windows, Linux, and Mac),
while upper-lower (DiffDogServer) works only on Windows and Mac.
* Use forward slashes on Linux and Mac, backslashes on Windows.

where

--h | --help Displays the help text.

--version Displays the version of DiffDog Server.
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Valid CLI commands are listed below and are explained in the sub-sections of this section.

assignlicense Upload a license to LicenseServer and assign it to DiffDog
Server on this machine.

createconfig Resets the server configuration file to default settings.

debug Starts DiffDog Server for debugging (not as a service).

exportresourcestrings Exports all application resource strings to an XML file.

help Displays help for a specific command.
For example: help run

install Installs DiffDog Server as a service.

licenseserver Register DiffDog Server with LicenseServer on the local
network.

setdeflang | sdl Sets the default language.

start Starts DiffDog Server as a service.

uninstall Uninstalls DiffDog Server as a service.

verifylicense Check if the current DiffDog Server is licensed; optionally,
check if a given license key is assigned.
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4.1 assignlicense (Windows only)

This section: 

Command syntax  
Command description  
Examples 
Command options 

Command syntax

Windows DiffDogServer assignlicense [options]  FILE

Note: This command is supported only on Windows systems. It is not supported on Linux or
Mac systems.

Command description
On execution, the assignlicense command uploads the license file specified by the FILE

argument to the registered LicenseServer, and assigns the license to DiffDog Server on this
machine. The FILE argument takes the filepath of the license file.

The --test-only option allows you to upload to LicenseServer and validate the license, without
assigning the license to DiffDog Server. For details about licensing, see the LicenseServer
documentation.

Examples
Examples of the assignlicense command:

diffdogserver assignlicense C:\DiffDog Server12345.altova_licenses

diffdogserver assignlicense --test-only=true C:\DiffDog

Server12345.altova_licenses

The first command above uploads the specified license to LicenseServer and assigns it to DiffDog
Server.
The second command uploads the specified license to LicenseServer and validates it, without
assigning it to DiffDog Server.

Casing and slashes on the command line

DiffDogServer on Windows

diffdogserver on Unix (Linux, Mac) 

* Note that lowercase (diffdogserver) works on all platforms (Windows, Linux, and Mac),
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while upper-lower (DiffDogServer) works only on Windows and Mac.
* Use forward slashes on Linux and Mac, backslashes on Windows.

Command options
Options are listed in their short forms (in the first column) and long forms (second column),
together with their descriptions (third column). On the command line, one or two dashes can be
used for both short and long forms.

--t --test-only Values are true|false. If true, then the license file is only
uploaded to LicenseServer and validated. It is not assigned to
DiffDog Server. Form: --test-only=true|false. Set to true if the
option is specified without a value.
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4.2 createconfig

This command creates a server configuration file with default settings for all options. Note that
running this command without specifying the --f, --force option will overwrite any existing
configuration file. If you do not want that, set the --f, --force option to false.

For more information about the configuration file, see Server Configuration File.

Syntax

Windows DiffDogServer createconfig [options]

Linux diffdogserver createconfig [options]

Mac diffdogserver createconfig [options]

Options

Option Description

--f, --force When true, any existing server configuration file will be
overwritten. When false, the command will create a
server configuration file only if one doesn't exist already.
The default value is true.

--lang Sets the value of the language parameter in the
configuration file. Valid languages are en, es, de, fr,
ja.

Examples
To create a default configuration file and set the command line interface language to German, use:

DiffDogServer createconfig --lang=de
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4.3 debug

This section: 

Command syntax  
Command description  
Examples 

Command syntax

Windows DiffDogServer debug  

Linux diffdogserver debug  

Mac diffdogserver debug  

Command description
The debug command starts DiffDog Server for debugging—not as a service. To stop DiffDog Server

in this mode, press Ctrl+C. The command takes no options.

Examples
Examples of the debug command:

diffdogserver debug

Casing and slashes on the command line

DiffDogServer on Windows

diffdogserver on Unix (Linux, Mac) 

* Note that lowercase (diffdogserver) works on all platforms (Windows, Linux, and Mac),
while upper-lower (DiffDogServer) works only on Windows and Mac.
* Use forward slashes on Linux and Mac, backslashes on Windows.



44 DiffDog Server Command Line exportresourcestrings

© 2018 Altova GmbHAltova DiffDog Server 2018 

4.4 exportresourcestrings

This section: 

Command syntax  
Arguments  
Command description  
Examples 
Creating localized versions of DiffDog Server 

Command syntax

Windows DiffDogServer exportresourcestrings LanguageCode XMLOutputFile  

Linux diffdogserver exportresourcestrings LanguageCode XMLOutputFile 

Mac diffdogserver exportresourcestrings LanguageCode XMLOutputFile 

Arguments
The  exportresourcestrings command takes the following arguments:

LanguageCode Specifies the language of resource strings in the exported XML file.
Supported languages are: en, de, es, fr, ja

XMLOutputFile Specifies the location and name of the exported XML file.

Command description
The exportresourcestrings command outputs an XML file containing the resource strings of the

DiffDog Server application. It takes two arguments: (i) the language of the resource strings in the
output XML file, and (ii) the path and name of the output XML file. Allowed export languages (with
their language codes in parentheses) are: English (en), German, (de), Spanish (es), French (fr),
and Japanese (ja).

Examples
An example of the exportresourcestrings command:

diffdogserver exportresourcestrings de c:\Strings.xml 

This command creates a file called Strings.xml at c:\ that contains all the resource strings of
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the DiffDog Server application in German.

Casing and slashes on the command line

DiffDogServer on Windows

diffdogserver on Unix (Linux, Mac) 

* Note that lowercase (diffdogserver) works on all platforms (Windows, Linux, and Mac),
while upper-lower (DiffDogServer) works only on Windows and Mac.
* Use forward slashes on Linux and Mac, backslashes on Windows.

Creating localized versions of DiffDog Server
You can create a localized version of DiffDog Server for any language of your choice. Five
localized versions (English, German, Spanish, French, and Japanese) are already available in the 
C:\Program Files (x86)\Altova\DiffDogServer2018\bin folder, and therefore do not need to
be created.

Create a localized version as follows:

1. Generate an XML file containing the resource strings by using the 
exportresourcestrings command (see command syntax above). The resource strings
in this XML file will be one of the five supported languages: English (en), German (de),
Spanish (es), French (fr), or Japanese (ja), according to the LanguageCode argument

used with the command.
2. Translate the resource strings from one of the four supported languages into the target

language. The resource strings are the contents of the <string> elements in the XML
file. Do not translate variables in curly brackets, such as {option} or {product}.

3. Contact Altova Support to generate a localized DiffDog Server DLL file from your
translated XML file.

4. After you receive your localized DLL file from Altova Support, save the DLL in the C:
\Program Files (x86)\Altova\<%APPFOLDER\bin folder. Your DLL file will have a
name of the form DiffDogServer2018_lc.dll. The _lc part of the name contains the
language code. For example, in DiffDogServer2018_de.dll, the de part is the language
code for German (Deutsch). 

5. Run the setdeflang command to set your localized DLL file as the DiffDog Server
application to use. For the argument of the setdeflang command, use the language
code that is part of the DLL name.

Note: Altova DiffDog Server is delivered with support for five languages: English, German,
Spanish, French, and Japanese. So you do not need to create a localized version of
these languages. To set any of these languages as the default language, use DiffDog
Server's setdeflang command. 

http://www.altova.com/support
http://www.altova.com/support
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4.5 help

This section: 

Command syntax  
Command description  
Examples 
The --help option 

Command syntax

Windows DiffDogServer help Command  

Linux diffdogserver help Command 

Mac diffdogserver help Command 

Command description
The help command takes a single argument (Command): the name of the command for which help

is required. It displays the correct syntax of the command and other information relevant to the
correct execution of the command.

Examples
An example of the help command:

diffdogserver help exportresourcestrings 

The command above contains one argument: the command exportresourcestrings, for which
help is required. When the example command above is executed, information about the 
exportresourcestrings command will be displayed in the terminal.

Casing and slashes on the command line

DiffDogServer on Windows

diffdogserver on Unix (Linux, Mac) 

* Note that lowercase (diffdogserver) works on all platforms (Windows, Linux, and Mac),
while upper-lower (DiffDogServer) works only on Windows and Mac.
* Use forward slashes on Linux and Mac, backslashes on Windows.
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The --help option

Help information about a command is also available by using the --help option with the
command for which help information is required. For example, using the --help option with the
exportresourcestrings command, as follows:

diffdogserver exportresourcestrings --help 

achieves the same result as does using the help command with an argument of
exportresourcestrings: 

diffdogserver help exportresourcestrings 

In both cases, help information about the exportresourcestrings command is displayed.
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4.6 install

This section: 

Command syntax  
Command description  
Examples 

Command syntax

Windows DiffDogServer install  

Linux diffdogserver install  

Mac diffdogserver install  

Command description
The install command installs DiffDog Server as a service on the server machine. The command
takes no options.

Note that installing DiffDog Server as a service, does not automatically start the service. To start
the service, use the start command. To uninstall DiffDog Server as a service, use the uninstall
command.

Examples
Examples of the install command:

diffdogserver install

Casing and slashes on the command line

DiffDogServer on Windows

diffdogserver on Unix (Linux, Mac) 

* Note that lowercase (diffdogserver) works on all platforms (Windows, Linux, and Mac),
while upper-lower (DiffDogServer) works only on Windows and Mac.
* Use forward slashes on Linux and Mac, backslashes on Windows.
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4.7 licenseserver

This section: 

Command syntax  
Command description  
Examples 
Command options 

Command syntax

Windows DiffDogServer licenseserver [options] Server-Or-IP-Address  

Linux diffdogserver licenseserver [options] Server-Or-IP-Address 

Mac diffdogserver licenseserver [options] Server-Or-IP-Address

Command description
On execution, the licenseserver command registers DiffDog Server with the LicenseServer
specified by the Server-Or-IP-Address argument. Server-Or-IP-Address identifies the

machine on the network on which Altova LicenseServer is installed and running. It can be the
machine's name or its IP address.

For the licenseserver command to be executed successfully, the two servers must be
connected on the network and LicenseServer must be running. You must have administrator
privileges to be able to register DiffDog Server with LicenseServer.

Once DiffDog Server has been successfully registered with LicenseServer, you will receive a
message to this effect. The message will also display the URL of the LicenseServer. You can now
go to LicenseServer to assign DiffDog Server a license. For details, see the LicenseServer
documentation.

Examples
Examples of the licenseserver command:

diffdogserver licenseserver DOC.altova.com 

diffdogserver licenseserver localhost 

diffdogserver licenseserver 127.0.0.1 

The commands above specify, respectively, the machine named DOC.altova.com, and the user's
machine (localhost and 127.0.0.1) as the machine running Altova LicenseServer. In each case,
the command registers DiffDog Server with the LicenseServer on the machine specified.
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Casing and slashes on the command line

DiffDogServer on Windows

diffdogserver on Unix (Linux, Mac) 

* Note that lowercase (diffdogserver) works on all platforms (Windows, Linux, and Mac),
while upper-lower (DiffDogServer) works only on Windows and Mac.
* Use forward slashes on Linux and Mac, backslashes on Windows.

Command options
Options are listed in their short forms (in the first column) and long forms (second column),
together with their descriptions (third column). On the command line, one or two dashes can be
used for both short and long forms.

--j --json Prints the result of the registration attempt as a machine-parsable JSON
object. Form: --json=true|false
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4.8 setdeflang

This section: 

Command syntax  
Command description  
Examples 
Supported languages 

Command syntax

Windows DiffDogServer setdeflang | sdl LangaugeCode  

Linux diffdogserver setdeflang | sdl LangaugeCode 

Mac diffdogserver setdeflang | sdl LangaugeCode

Command description
The setdeflang command (short form is sdl) sets the default language of DiffDog Server. It takes

a mandatory LanguageCode argument.

Examples
An example of the setdeflang command:

diffdogserver setdeflang DE 

The command above sets the default language for messages to German.

Casing and slashes on the command line

DiffDogServer on Windows

diffdogserver on Unix (Linux, Mac) 

* Note that lowercase (diffdogserver) works on all platforms (Windows, Linux, and Mac),
while upper-lower (DiffDogServer) works only on Windows and Mac.
* Use forward slashes on Linux and Mac, backslashes on Windows.

Supported languages
The table below lists the languages currently supported together with their language codes.

EN English
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DE German

ES Spanish

FR French

JA Japanese
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4.9 start

This section: 

Command syntax  
Command description  
Examples 

Command syntax

Windows DiffDogServer start  

Linux diffdogserver start  

Mac diffdogserver start  

Command description
The start command starts DiffDog Server as a service on the server machine. The command
takes no options.

Note that, if DiffDog Server is not installed as a service, you can install it with the install
command. To uninstall DiffDog Server as a service, use the uninstall command.

Examples
Examples of the start command:

diffdogserver start

Casing and slashes on the command line

DiffDogServer on Windows

diffdogserver on Unix (Linux, Mac) 

* Note that lowercase (diffdogserver) works on all platforms (Windows, Linux, and Mac),
while upper-lower (DiffDogServer) works only on Windows and Mac.
* Use forward slashes on Linux and Mac, backslashes on Windows.



54 DiffDog Server Command Line uninstall

© 2018 Altova GmbHAltova DiffDog Server 2018 

4.10 uninstall

This section: 

Command syntax  
Command description  
Examples 

Command syntax

Windows DiffDogServer uninstall  

Linux diffdogserver uninstall  

Mac diffdogserver uninstall  

Command description
The uninstall command uninstalls DiffDog Server as a service on the server machine. The
command takes no options.

To re-install DiffDog Server as a service, use the install command.

Examples
Examples of the uninstall command:

diffdogserver uninstall

Casing and slashes on the command line

DiffDogServer on Windows

diffdogserver on Unix (Linux, Mac) 

* Note that lowercase (diffdogserver) works on all platforms (Windows, Linux, and Mac),
while upper-lower (DiffDogServer) works only on Windows and Mac.
* Use forward slashes on Linux and Mac, backslashes on Windows.



© 2018 Altova GmbH

verifylicense (Windows only) 55DiffDog Server Command Line

Altova DiffDog Server 2018 

4.11 verifylicense (Windows only)

This section: 

Command syntax  
Command description  
Examples 
Command options 

Command syntax

Windows DiffDogServer verifylicense [options]  

Note: This command is supported only on Windows systems. It is not supported on Linux or
Mac systems.

Command description
Checks whether the current product is licensed. Additionally, the --license-key option enables
you to check whether a specific license key is already assigned to the product. For details about
licensing, see the LicenseServer documentation.

Examples
Examples of the verifylicense command:

diffdogserver verifylicense 
diffdogserver verifylicense --license-key=ABCDEFG-HIJKLMN-OPQRSTU-VWXYZ12-

3456789

The commands above check, respectively, whether the product has been licensed, and whether
the product has been licensed with the license key given as the value of the --license-key
option.

Casing and slashes on the command line

DiffDogServer on Windows

diffdogserver on Unix (Linux, Mac) 

* Note that lowercase (diffdogserver) works on all platforms (Windows, Linux, and Mac),
while upper-lower (DiffDogServer) works only on Windows and Mac.
* Use forward slashes on Linux and Mac, backslashes on Windows.
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Command options
Options are listed in their short forms (in the first column) and long forms (second column),
together with their descriptions (third column). On the command line, one or two dashes can be
used for both short and long forms.

--l --license-key Checks whether the submitted license key has already been
assigned to the product. Form: --license-key=VALUE



Chapter 5

DiffDog Client Command Line
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5 DiffDog Client Command Line

This chapter describes the commands exposed by the DiffDog Command Line Client. 

diff
import
showcfg

To display help for any of these commands directly at the command line, use:

DiffDogCmdlClient <command> --help

On Linux, use an all-lowercase to call the executable. In addition, on Linux and OS X / macOS,
when you are inside the directory of the executable, you might need to add the prefix "./" before
the name of the executable.

For the path to the DiffDog Command Line Client (abbreviated as DiffDogCmdlClient), see How It
Works.
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5.1 diff

The diff command performs a side-by-side comparison of two files, directories, or URLs. The
entities to be compared can be of different kinds (for example, you can compare a URL like http://
server/file.txt to a file path like C:\file.txt).

This command can also be called using the compare alias. You can use compare and diff
interchangeably.

Most often, a comparison involves a "left" side and a "right" side to compare; however, three-way
comparisons are also possible when comparing files or URLs (not directories). The files or
directories to be compared can be on a machine where DiffDog Client runs or on the remote
machine where DiffDog Server runs. A combined approach (comparison of local files or directories
with remote ones) is also possible.

Syntax

DiffDogCmdlClient diff [options] [path path [path]]

On Linux, use an all-lowercase to call the executable. In addition, on Linux and OS X / macOS,
when you are inside the directory of the executable, you might need to add the prefix "./" before
the name of the executable.

For the path to the DiffDog Command Line Client (abbreviated as DiffDogCmdlClient), see How It
Works.

Arguments
path
A path may be a file or directory path, or a URL path in the format http://server/segment. 

Supplying paths as arguments is just one of the two ways to pass input paths to the diff
command. The second way to supply paths is by setting the options --client-left, --client-
right, or --server-left, --server-right. Use the second approach if DiffDog Client does not
run on the same machine as DiffDog Server.

In other words, if you set the options --client-left, --client-right, or --server-left, --
server-right, then no paths must be specified as arguments. Otherwise, two paths exactly
must be supplied as argument. (To perform a three-way comparison, three paths can be specified
as arguments.)

Note that it is valid to compare files with URLs, for example, but not files and directories (or URLs
and directories).

Options
The options applicable to the diff command are listed below.
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You can specify defaults for most of the options below in the client configuration file. If you
use a client configuration file, note the following:

When an option is set at the command line but it is commented out in client
configuration file, the command line option applies.
When an option is set both at the command line and in client configuration file, the
command line option applies.
When an option is not set at the command line but is set (uncommented) in
configuration file, the configuration file option applies.
When an option is set neither at the command line nor in the configuration file, it
takes the default value as described in the command line help and in the
documentation below.

--c, --config
This option specifies the path to a client configuration file. For more information, see Client
Configuration File.

If you do not set the --c option, the DiffDog Command Line Client executable attempts to read
the client configuration file from the same directory. If there is no configuration file in the same
directory as the executable, the default values as described in the command line help and this
documentation apply.

--cl, --client-left
This option specifies the left side of the comparison (must be a path to a local file or directory).

--cm, --client-middle
This option is applicable in a 3-way comparison. It specifies the local path to the "middle" file
(also known as the "common ancestor").

--cr, --client-right
This option specifies the right side of the comparison (must be a path to a local file or directory).

--dc, --dir-compare-contents
This option specifies if directory comparison should compare file contents in addition to any other
options that might be set separately (such as file size and modification date). When this option is 
false, the comparison ignores file contents (this will result in a faster, though less accurate,
comparison). By default, this option is false.

--df, --directory-filter
This option is applicable for directory comparisons. Directory filters enable you to include or
exclude certain files or sub-directories from the comparison based on criteria you define. Valid
values for this option are directory filters as they are defined in the Client Configuration File, in the
[dir.filter] group. For example, if the configuration file defines a filter [dir.filter:svn], use the
following syntax to set the filter at the command line:

--directory-filter=svn

On Windows, when DiffDog is installed on the same machine as DiffDog Server, you can specify
as option value any directory filter that already exists in DiffDog (either built-in or custom). For
example, to set the built-in filter "No SVN directories" at the command line, use the following
syntax:



© 2018 Altova GmbH

diff 61DiffDog Client Command Line

Altova DiffDog Server 2018 

--directory-filter="No SVN directories"

To view or create a directory filter in DiffDog:

1. On the Tools menu, click DiffDog Options.
2. Click the Directory Comparison tab.

For more information about creating directory filters with DiffDog, refer to DiffDog documentation
(https://www.altova.com/documentation).

If the filter cannot be found, an error occurs and no comparison takes place.

--di, --dir-compare-mod-times-ignore-seconds
This option is applicable for directory comparisons. It specifies that directory comparison should
ignore the given number of seconds (+/-) when comparing modification times. By default, it is set
to 0, which means the comparison will not ignore modification time differences.

--dic, --dir-ignore-case
This option is applicable for directory comparisons. By default, this value is true, which means
that the comparison ignores the case in file or directory names. For example, a directory
"SomeDir" would be equal to "somedir", or a file "somefile.txt" would be equal to
"SomeFile.txt" (assuming that their content is also equal).

To take the case of file or directory names into account when comparing, set the option to false.

--ds, --dir-compare-sizes
This option is applicable for directory comparisons. When set to true, it specifies that directory
comparison should compare files by size. Otherwise, this comparison criterion is ignored. By
default, this option is false.

--dt, --dir-compare-mod-times
This option is applicable for directory comparisons. When set to true, it specifies that directory
comparison should compare files within a directory by modification time. Otherwise, this
comparison criterion is ignored. By default, this option is false.

--ib, --ignore-blank-lines
This option specifies if blank lines should be ignored in comparison. Valid values are true and
false. By default, this value is false.

--ic, --ignore-case
This option is applicable to file comparisons. Valid values:

true Perform a case-insensitive comparison (for example, "A" and "a" are treated as
equal).

false (Default) Perform a case-sensitive comparison (for example, "A" and "a" are not
treated as equal).

--m, --mode
This option specifies the comparison type to be performed. Valid values:

https://www.altova.com/documentation
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auto (Default) Let the application determine if the supplied arguments are files or
directories and set the comparison mode automatically based on file extension. For
example, if files are detected to be XML, then an XML comparison is performed. You
can always view or change the default mapping between specific file extensions and
comparison modes, see Client Configuration File.

binary Treat files as binary.

text Treat files as text.

xml Treat files as XML.

--o, --output-file
This option enables you to write the command output to a text file on the client machine. The
value must specify a valid file path on the client machine. Use the --om option to set the output
file format.

--om, --output-mode
This option lets you specify the format in which the comparison output is to be created (text or
XML). Valid values:

auto (Default) Let the application decide.

text Write output file as text. 

Note: The option --output-mode=text is not supported when
comparing XML files. If you set the --output-mode to text when
comparing XML files, no differences will be reported in the
standard output. If you additionally set the --output-file option,
a zero-sized output file will be created.

xml Write output file as XML.

--port
This option specifies the port on which DiffDog Server listens for requests. Setting this option is
meaningful if DiffDog Server runs on a port other than the default 29800. As an alternative to
setting this option at the command line, you can set it in the Client Configuration File. Note that, if
you set this value at the command line, it takes precedence over the one defined in the
configuration file.

--q, --quiet
Prevents the standard output from being displayed at the command line. Valid values:

true Do not display standard output in the terminal window.

false (Default) Display standard output in the terminal window.

--s, --server-output-file
This option enables you to write the command output to a text file on the server machine. The
value must specify a valid file path on the server machine. Use the --om option to set the output
file format.
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--server
This option specifies the server address on which DiffDog Server listens for requests. Setting this
option is meaningful if DiffDog Server runs on a server other than the default localhost. As an
alternative to setting this option at the command line, you can set it in the Client Configuration
File. Note that, if you set this value at the command line, it takes precedence over the one defined
in the configuration file.

--sl, --server-left
This option enables you to add a remote path to the comparison. It specifies the left side of the
comparison (a path to a file or directory accessible to the server).

--sm, --server-middle
This option enables you to add a remote path to the comparison. It specifies the middle side of
the comparison (applicable in a 3-way comparison). The value must be a path to a file or directory
accessible to the server.

--sr, --server-right
This option enables you to add a remote path to the comparison. It specifies the right side of the
comparison (a path to a file or directory accessible to the server).

--ws, --whitespace-mode
This option is applicable when you compare text and XML files. It defines how whitespace
characters should be treated for comparison. Whitespace characters are any of the following:
space, tab, carriage return, and line feed. Not specifying this option means that whitespace
characters are always relevant for comparison. Otherwise, set one of the following values:

normalize Text A is equal to Text B if, after normalization, characters in Text A
correspond to those in Text B. “Normalization” means that multiple
consecutive occurrences of whitespace characters are replaced by a
single space character. In addition, the leading and trailing whitespace
characters are trimmed for each line of text. If the compared files are
XML, the leading and trailing whitespace characters in attribute values
are trimmed.

strip Text A is considered equal to Text B if, after stripping whitespace
characters, characters in Text A correspond to those in Text B. In other
words, any whitespace characters are stripped from the text and
considered not relevant for comparison. If the compared files are XML, 
whitespace characters that are outside attribute or element values are
disregarded for comparison.

--xf, --xml-filter
This option is applicable for XML comparisons. An XML filter contains rules that ignore specific
XML attributes or elements for comparison. Valid values for this option are XML filters as they are
defined in the Client Configuration File, in the [xml.filter] group. For example, if the configuration
file defines a filter [xml.filter:ignore-abc-elems], use the following syntax to set the filter at the
command line:

--xml-filter=ignore-abc-elems

On Windows, when DiffDog is installed on the same machine as DiffDog Server, you can specify
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as option value any XML filter created with DiffDog. To view or define an XML filter in DiffDog, take
the following steps:

1. On the Tools menu, click Comparison Options.
2. Click the XML tab.

3. Locate the option Filter out specific elements/attributes, and the click the Ellipsis 
button .

For more information about creating XML filters with DiffDog, refer to DiffDog documentation
(https://www.altova.com/documentation).

If the filter cannot be found, an error occurs and no comparison takes place.

--xicin, --xml-ignore-case-in-names
This option is applicable when comparing XML files. When set to true, a case-insensitive
comparison of XML identifier names will be performed. For example, let's assume that you want to
compare the following XML files:

<book ID="1"/> <book id="1"/>

In the listing above, the attribute ID is uppercase in the left file and lowercase in the right file. If --
xml-ignore-case-in-names=true, case is ignored, so the files above are treated as equal. By
default, this option is false, which means files such as the ones above are not equal.

--xicit, --xml-ignore-case-in-text
This option is applicable when comparing XML files. When set to true, a case-insensitive
comparison of non-markup text will be performed. For example, let's assume that you want to
compare the following XML files:

<book hardcover="yes">

   <genre>fiction</genre>

</book>

<book hardcover="Yes">

   <genre>Fiction</genre>

</book>

In the listing above, the value of attribute hardcover is lowercase in the left file and capitalised in
the right file. The same is true for the value of the genre element. To treat these two files as
equal, set --xml-ignore-case-in-text=true. By default, this option is false, which means files
such as the ones above are not equal.

--xima, --xml-ignore-markup-attributes
This option is applicable when comparing XML files. Valid values:

true Ignore XML attributes when comparing.

false (Default) Take XML attributes into account when comparing.

--ximc, --xml-ignore-markup-comments
This option is applicable when comparing XML files. Valid values:

https://www.altova.com/documentation
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true Ignore XML comments when comparing.

false (Default) Take XML comments into account when comparing.

--ximcd, --xml-ignore-markup-cdata
This option is applicable when comparing XML files. Valid values:

true Ignore XML character data (CDATA) when comparing.

false (Default) Take XML CDATA into account when comparing.

--ximd, --xml-ignore-markup-doctype
This option is applicable when comparing XML files. Valid values:

true Ignore XML DOCTYPE declaration when comparing.

false (Default) Take XML DOCTYPE declaration into account when comparing.

--ximpi, --xml-ignore-markup-processing-instructions
This option is applicable when comparing XML files. Valid values:

true Ignore XML processing instructions when comparing.

false (Default) Take XML processing instructions into account when comparing.

--ximx, --xml-ignore-markup-xml
This option is applicable when comparing XML files. Valid values:

true Ignore XML declarations when comparing.

false (Default) Take XML declarations into account when comparing.

   --xins, --xml-ignore-namespace
This option is applicable when comparing XML files. When set to true, XML namespaces will be
ignored. By default, this option is false.

--xip, --xml-ignore-prefixes
This option is applicable when comparing XML files. When set to true, XML prefixes will be
ignored. By default, this option is false.

--xit, --xml-ignore-text
This option is applicable when comparing XML files. When set to true, the text content of XML
nodes will be ignored for comparison. This is useful if you want to compare only the structure of
two XML files, disregarding the actual node content. By default, this option is false.

--xoba, --xml-order-by-attributes
This option is applicable when comparing XML files. Set this option to true if you want all XML
attributes to be ordered before comparison. For example, let's assume that you want to compare
the following two XML files:
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<book author="Franz Kafka" title="The

Metamorphosis"/>

<book title="The Metamorphosis"

author="Franz Kafka"/>

In the listing above, the order of attributes is different in both files, although the attributes are the
same. If you set the option --xml-order-by-attributes to true, the application will order
attributes before comparison, and, consequently, the files will be reported as equal. The default
value is false, meaning that files are not equal if the order of attributes is not the same.

--xobe, --xml-order-by-elements
This option is applicable when comparing XML files. Set this option to true if you want all XML
elements to be ordered before comparison. For example, let's assume that you want to compare
the following two XML files:

<book>

   <author>Franz Kafka</author>

   <title>The Metamorphosis</title>   

</book>

<book>   

   <title>The Metamorphosis</title>

   <author>Franz Kafka</author>

</book>

In the listing above, the left and right files contain exactly the same elements, only in a different
order. If you set the option --xml-order-by-elements to true, the application will order all
elements before comparison, and consequently, the files will be reported as equal. The default
value is false, meaning that files are different if the order of elements is different.

--xobl, --xml-order-by-attribute-list
This option is applicable when comparing XML files. There are instances where multiple elements
have exactly the same name and attributes, but attribute values are different. To sort by specific
attributes before comparing, set this option to a named list of attributes created in the Client
Configuration File, in the [xml.orderby:<name_of_your_list>] group.

For example, let's assume that you want to compare the following two XML files:

<data>

   <phone type="work" ext="111"/> 

   <phone type="work" ext="222"/> 

   <phone type="work" ext="333"/> 

</data>

<data>

   <phone type="work" ext="333"/> 

   <phone type="work" ext="111"/> 

   <phone type="work" ext="222"/> 

</data>

In the listing above, the left and right files are not equal. However, if you ordered all phone
elements by ext attribute, then the files would become equal. To make such comparisons
possible, first modify the client configuration file as follows:

;; an example attributes list

[xml.orderby:mylist]

attributes = ext

You can now run the diff command with the option --xml-order-by-attribute-list=mylist.
When you do this, the application orders elements by ext attribute, and, as a result, the files are
reported as equal. If the option --xml-order-by-attribute-list is not set, files such as the
ones above would be reported as NOT equal.
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As an alternative, to order by all attributes, set the option --xml-order-by-attributes=true
instead of setting this option.

Note: If you set the --xml-order-by-attribute-list option, make sure to also set the --
xml-order-by-elements=true.

On Windows, when DiffDog is installed on the same machine as DiffDog Server, you can set this
option to a custom attribute list created in DiffDog. To view or create a custom attribute list in
DiffDog:

1. On the Tools menu, click Comparison Options.
2. Click the XML tab.
3. Select the Ignore order of child nodes check box.

4. Click Specific attributes, and then click the Ellipsis  button.

For more information about creating custom attribute lists with DiffDog, refer to DiffDog
documentation (https://www.altova.com/documentation).

--xobt, --xml-order-by-text
This option is applicable when comparing XML files. There are instances where multiple elements
have exactly the same name and attributes; only the text of elements is different. Set this option
to true if you want to order such elements by their inner text before comparison. For example,
let's assume that you want to compare the following files:

<data>

   <phone type="mobile">111</phone>

   <phone type="mobile">222</phone>   

</data>

<data>

   <phone type="mobile">222</phone>

   <phone type="mobile">111</phone> 

</data>

In the listing above, the left and right files are not equal. However, if you set the option --xml-
order-by-text to true, the application would order elements by their text, and, as a result, the
files would be reported as equal. The default value is false, meaning that ordering of elements by
text does not take place, and files such as the ones above are not equal.

Note: If you set the --xml-order-by-text option, make sure to also set the --xml-order-by-
elements=true.

--xre, --xml-resolve-entities
This option is applicable when comparing XML files. When set to true, then all entities in the
document are resolved. Otherwise, the files are compared with the entities as is. By default, this
option is false.

--zd, --zip-as-dir
This option is applicable when comparing ZIP files. When set to true, ZIP files will be treated as
directories instead of binary files. By default, this option is false.

Handling the output
When you run a comparison, you can view the comparison result directly at the command line, or
output it to a report in XML or text format. Set the --output-mode option to specify the output

https://www.altova.com/documentation
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format. Set the --output-file option to redirect the output to a file.

Note: When you compare files in binary mode (that is, when the option --mode=binary),
DiffDog Server creates no output report, since listing differences is not meaningful for
binary files. In such cases, check the %ERRORLEVEL% environment variable to view the
comparison outcome. 

Error level Meaning

0 Files are equal

1 Differences exist

2 An error has occurred

For example, the following Windows batch script compares two PDF files in binary mode. The %
ERRORLEVEL% environment variable outputs the comparison outcome.

DiffDogCmdlClient diff "C:\book1.pdf" "C:\book2.pdf" --m=binary
ECHO %ERRORLEVEL%

Examples
To compare only local files or directories, supply them as arguments to the diff command. In
this case, if you supply two arguments (for example, two file paths) to the diff command, the
arguments will be interpreted in the following order: left side of the comparison, right side of the
comparison. 

DiffDogCmdlClient diff file1.txt file2.txt --mode=text

If you specify three arguments, a three-way comparison takes place, and the arguments are
interpreted in this order: left side of the comparison, middle side, and then right side.

DiffDogCmdlClient diff file1.xml file2.xml file3.xml --mode=xml

Note: While not mandatory, for best results it is recommended to explicitly set the --mode
option to either text, binary, or xml. Otherwise, the application would need to determine
automatically whether you are comparing files or directories, which may lead to undesired
results. In the first example above, the comparison mode is set to text since two text
files are being compared. In the second example, it is set to xml since three XML files are
being compared. 

Alternatively, you can specify the left and right side of the comparison through options instead of
arguments. For example, the command below compares two XML files on the machine where
DiffDog Client runs, and both file paths are supplied as options (not arguments):

DiffDogCmdlClient diff --client-left=file1.xml --client-right=file2.xml

When the comparison paths are set as options, you can compare not only files local to the client
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machine, but also remote files on the machine where DiffDog Server runs. For example, the
command below compares two text files where the left one is on the client and the right one is on
the server.

DiffDogCmdlClient diff --client-left=file1.txt --server-right=file2.txt

Note: The path syntax must be valid for the operating system where the file is. For example, if
the client runs on Windows and the server runs on Linux, then a Windows-style path
must be used for --client-left. Conversely, a Linux-style path must be used for --
server-right.

To perform a three-way comparison, add a third option (either --client-middle or --server-
middle, depending on where the common ancestor file is). In the example below, the common
ancestor file file2.csv is on the server machine while the left and right files (file1.csv, file3.csv)
are on the client machine.

DiffDogCmdlClient diff --client-left=file1.csv --server-middle=file2.csv --
client-right=file3.csv
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5.2 import

The import command runs a comparison provided that it is given a *.dirdif (directory comparison)
or *.filedif (file comparison) file as argument. You can create such files with Altova DiffDog
desktop application (https://www.altova.com/diffdog), by saving any file or directory comparison to
a .filedif or .dirdif file.

When you run this command, the outcome of the comparison is reported by the return error code
(0 = no differences, 1 = differences, 2 = error), similar to how it works with the diff command.
The output is displayed directly at the command line, unless you suppress it with the --quiet
option. You can optionally redirect the output (the comparison result) to a report file in XML or text
format. The path of the report file is defined from the graphical user interface of DiffDog desktop
application. Namely, in DiffDog, you can set the output path of a .filedif or .dirdif comparison as
follows:

1. Open an existing .dirdif or .filedif file (or create a new comparison) in DiffDog.
2. On the Tools menu, click Comparison Document Options.
3. Do one of the following:

a. To use no redirection to a file, click No Export (this is the default option).
b. To redirect the report to a text file, click Text file, and then enter the path in the

adjacent text box. 
c. To redirect the report to an XML file, click XML file, and then enter the path in the

adjacent text box. 
4. On the File menu, click Save As, and then save the comparison as .filedif (or .dirdif, if

applicable).

You can now run the .filedif or .dirdif file with DiffDog Server, as shown below.

Syntax

DiffDogCmdlClient import comparison-file1 [comparison-file2 [comparison-
fileN]]

The import command can also be called using the load alias. You can use import or load
interchangeably.

On Linux, use an all-lowercase to call the executable. In addition, on Linux and OS X / macOS,
when you are inside the directory of the executable, you might need to add the prefix "./" before
the name of the executable.

Arguments
comparison-file
Specifies the path to a comparison file in .dirdif or .filedif format. The path of the comparison file
can be absolute or relative to the current working directory. You can supply as many comparison
files as arguments as required. This is limited only by the number of input characters supported
by your command shell.

https://www.altova.com/diffdog
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Options
--quiet, --q
Prevents the standard output from being displayed at the command line. Valid values:

true Do not display standard output in the terminal window.

false (Default) Display standard output in the terminal window.

  

Example
Assuming that you would like to run the comparison file C:\DiffDog\Comparison1.filedif, use the
following command:

DiffDogCmdlClient import C:\DiffDog\Comparison1.filedif

Assuming that you would like to run the comparison file Comparison1.filedif and
Comparison2.dirdif (both located in C:\DiffDog directory), use the following command:

DiffDogCmdlClient import C:\DiffDog\Comparison1.filedif C:\DiffDog
\Comparison2.dirdif
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5.3 showcfg

The showcfg command outputs all the current DiffDog Client options in a human readable form.
The listed options are grouped into the following categories:

Application - This group lists any options that you've defined in the client configuration
file
Registry - (Windows-specific) This group lists options that exist in the Windows registry.
This is the case if DiffDog is installed on the same machine. Any custom XML or
directory filters that you created in DiffDog also appear here, see the --directory-
filter and --xml-filter options. Any "order by" attribute lists that you created in
DiffDog also appear here, see the --xml-order-by-attribute-list option.
Built-In - This group lists options that are built into the executable. The application will
default to these options when no others exist.

Syntax

DiffDogCmdlClient showcfg [options] [all]

On Linux, use an all-lowercase to call the executable. In addition, on Linux and OS X / macOS,
when you are inside the directory of the executable, you might need to add the prefix "./" before
the name of the executable.

Arguments
all
Output all configuration options. This argument is optional.

Options
The options applicable to the showcfg command are listed below.

--c, --config
This option specifies the path to a client configuration file. For more information, see Client
Configuration File.
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